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4 Ways to Place an Order

1. From an application ( Word, Excel, PowerPoint, Adobe, etc.)

2. A Special Order
3. A Catalog Order

4. From My Files



1. Placing an Order from an Application

1.1 From a Windows Application

Select File > Print
Select > Copy Center Printer
Select > Print ( this will convert the file into a PDF and KE E P

bring you to the log on page) Do Not choose any print CALM

YOU’RE AN
AWESOME
TEACHER




1. Placing an Order from an Application

C | & Secure | https://copycenter.pfisd.net/open/login Q 7 % i

1.2 Log into Copy Center Website

Enter User ID and Password (It is the same as
your standard ID and password)

Click Login




1. Placing an Order from an Application

i ] AWESOME TEACHER.pdf has been added to your order. Clear Messages
—
BriSD
1.3 Document Added to Cart
\.1'/ Cart
Select print options, quantity per recipient and billing information. Click Place Order to submit your order CartID 302241
Order name Order 302241 (SurePDF) Order Estimate 50.01
em W RepsceFie | | Comtoe Shpping|
& AWESOME TEACHER.pdf Vi Unit Price $0.01
1 Page .
Gun | 8.50x11.00 Inches Quantity |1
YOURE AN
SR
TEACHER Click the image to review the procf.

Select your print options, then click Preview to review thia item priar to ardering.

Your Selected Print Options Print B/W, 1-Sided, 8.5 x 11 White 20 Ib, Scale Down Only

ﬁ Preview | Change Options

Please approve this document for printing:

I have viewed the proof and preview (when available) and approve the document for printing.

Enter special i ions for this item.

Shipping Information | Add Address |

I would like my order shipped by: Tuesday, June 06, 2017

Nate: Only dates when the print center is open may be selected.

Lauren Tarbet /" Select a Shipping Method
;.IDJI;V\INISTRATIVE | PISD DELIVERY ¥ | Thiswill be delivered with campus mail
m;: States Delivery Estimate

Wednesday, June 07, 2017

Ordered ltems Quantity
1 AWESOME TEACHER pdf 1

Enter shipping instructions for this recipient

Billing Information
Lauren Tarbet Vi Order Estimate 50.01
ADMINISTRATIVE Click the price to view the cost details
500 Al
Texes Select Billing Codes for Payment
United States District Account Code Mo Valid Account Codes 0 %

If the account code is not found in the dropdown box
ahove, please enter it below,

District Account Code |
Example: 199.71.6399.00.000.7.99.100

OUT of District Cash/Check | v
Specify Cash or Check and raxsbie or non-taxshie

17

Total Split Percentage 0%



1. Placing an Order from an Application

H awesome TEACHER.pdf has been added to your order. Clear Messages

1.4 Choose either:

J/Cart

Checkout — you do not need any additional items

Order name Order 302241 (SurePDF)

Order Estimate 50.01

printed, continue with ordering on this page W o s

AWESOME TEACHER.pdf

Unit Price 50.01
i‘: 1 Page i
CALK 8.50x11.00 Inches Quantity |1
YOURE AN
ANESOUE
TRACHER Click the image to review the procf.

Select your print options, then click Preview to review this item prior to ordering.

Continue Shopping — you would like to add other N et

i Preview | Change Options

items to this cart (cont. on next page) R e e S S

Enter special instructions for this item.

Shipping Information | Add Address |

I would like my order shipped by: Tuesday, June 06, 201

Nate: Only dates when the print center is open may be selected.

Lauren Tarbet /" Select a Shipping Method
:;.IDJI;\’“NIS'TRATI\I'E | PISD DELIVERY ¥ | Thiswill be delivered with campus mail
-L[;?::i States Delivery Estimate

Wednesday, June 07, 2017

Ordered Items

1 AWESOME TEACHER pdf

Quantity

Enter shipping instructions for this recipient

Billing Information

Lauren Tarbet 7 Order Estimate 50.01
ADMINISTRATIVE Click the price to view the cost details
500 Al
Texas Select Billing Codes for Payment
United States

District Account Code Mo Valid Account Codes

]

If the account code is not found in the dropdown box
above, please enter it below.

District Account Code |

11.6399.00.000.7.99.100
OUT of District Cash/Check |

Specify Casl heck and taxsbiz or non-1axshie

Example

1

Total Split Percentage 0% -



1. Placing an Order from an Application

1.5 Adding Additional Item to Cart

Open next document and Repeat Step 1.1
Select > My Cart

Select > Checkout ( your cart now has 2 items and
you may continue with ordering)




2. Placing a Special Order

What are Special Orders?

Orders where an electronic copy of the document is not =
uploaded to the Copy Center site. Add Document to Order

Common Special Orders:

Hardcopy documents
Files on CD or USB
Files that are not accepted for uploading

Log-on to

You can also find the link by pressing the Staff tab on
the district website, or on the Intranet main page.



https://copycenter.pfisd.net/

2. Placing a $pecial Order

RSA WebCRD - UserID | X / RSA WebCRD - UserID | X

Select Go under the Special Orders box. Enter in the e

35 Apps RSA WebCRD  Bb Pflugerville Indepen E Split Neck Short Slee

Number of pages you will have in your document. Then
Proceed to fill in the rest of the information. Once you

PRINTING MADE EASY
ervices has never b

Have submitted your order online, put your hard copy in I~

Campus mail and reference your order number.




3. Placing a Catalog Order

What is a Catalog?

A collection of print items that are made available to all _f
PFISD users or only to specific users. Add Document to Order

Our PFISD Catalogs contains: e
Dibels
AIMS
DRAZ2- Eng/Span
Reading A-Z Books (limited)




3. Placing a Catalog Order

3.1 Use Search Catalog

Enter item/document name and click Go
or

Click Advanced Search

or

C I i C k G O b u tto n Orders Ma\:;ge Files Contacts Reports

l I Acting on behalf of e813349

PRINTING MADE EASY

Ordering from Document Services has never been easier. Upload a File from your desktop,
search for personal items in My Files or search the Catalog.

Upload A File Search Catalog My Files Special Orders

Select a file from your desktop. Search catalog by description for items to Search your personal file cabinet for items Order custom prints from a hardcopy, CD-
order. to order. ROM, etc.

-

pdf, gif, ipg. png, jpeg

Multiple Files? ~dvanced Search Advanced Search

© 2001-2015 Rochester Software Associates, Inc. All rights reserved.




3. Placing a Catalog Order

RSA WebCRD - User ID [ X 4 RSA WebCRD - UserID [ X

C | & Secure | https//copycenter.pfisd.net/fulfillment/from -

Apps RSA WebCRD  Bb Pflugerville Indepenc E] Split Neck Short Slee

.2 Enter quantity
.3 Click Add to Cart
4 Click Cart link

For template documents, click Configure to set up the template and add it to your cart. All items with guantities are added to your cart first.

| Search | | Ctear |

Home | My Account | Help | Logout

Homes Catalog > DIBELS > Benchmark Scaring Booklets

Item £

Search | Rows Per Page | 100 |

Show Advanced Search Criteria Sort By | itam v |

Benchmark Daze 63 Worksheets
aty | | Addto Cart |
F bt )
Locsted in DIBELS / Benchmark Scoring Booklets
] Benchmark Daze G4 Worksheets
aty " | Add o Cart |
% Cmileld)
Located in DIBELS / Benchmark Scoring Booklets
Benchmark Daze G5 Worksheets
Qty | Add to Cart |
% iscch i
Loezted in DIBELS / Benchmark Scoring Booklets

k 61 Scoring

any | Addto Cart

Lecated in DIBELS / Benchmark Scoring Booklets

Benchmark 62 Scoring
Oty | | Addto Cart |
Locsted in DIBELS / Benchmark Scoring Booklets

Benchmark 63 Scoring I}
- L !
5

Located in DIBELS / Benchmark Scoring Booklets

k G4 Scoring

{1 ay[ |[Padmcad)
11
Loeztad in DIBELS | Benchmark Scoring Booklets

k 65 Scoring

5
= T
‘ ay Add to Cart

Lecated in DIBELS / Benchmark Scoring Booklets




4. Placing Order from My Files

What are My Files?

A collection of your documents that you upload and =
configure for printing ahead of time. Add Document to Order

How to Set Up: s i
Use Manage Files to:

Create Folders

Upload files
Set Retention Time
Set Print Options




4. Placing Order from My Files

4.1 Use My Files

Enter item/document name and click Go
or

Click Advanced Search

or

C I i C k G O b u tto n Orde;'s Ma\:;ge Files Contacts Reports

l I Acting on behalf of e813349

PRINTING MADE EASY

Ordering from Document Services has never been easier. Upload a File from your desktop,
search for personal items in My Files or search the Catalog.

Upload A File Search Catalog My Files Special Orders

Select a file from your desktop. Search catalog by description for items to Search your personal file cabinet for items Order custom prints from a hardcopy, CD-
order. to order. ROM, etc.

==

‘

Multiple Files? Advanced Search Advanced Search

pdf, gif, ipg. png, jpeg

© 2001-2015 Rochester Software Associates, Inc. All rights reserved.




. Placing Order from My Files

RSA WebCRD - UserID | X

St fram
nt/fror

& C | @ Secure | https;//copycenter.pfisd.net,

Apps RSA WebCRD Bb Pflugerville Indepen R‘ Split Neck Short Slee

4.2 Enter quantity
4.3 Click Add to Cart
4.4 Click Cart link

For template doc ts, click Configure 1o set up the template and add it to your cart. All items

Home>My Files>default

antities d to your cart first.

Item £ b

Search i Rows PerPage | 100 +|

Show Advanced Search Criteria Sort By

2017.LPD Spring Show Dance through Decades.pdf

aty |

s Located in Folder default A\ Expires in 17 Days

10th ELA

Located in Folder default

10thELA

aty|

Located in Folder default

10thGr WH SS GE DA2 StuDataAnalysis.pdf
aty | [ Addto Cart |

Located in Folder default

10thGr WorldHistory SS DA2 OnLevel May2015.pdf

aty| | Add o Cart |

Located in Folder default

10thGr_SS_DA1 1415 AP di lysis.pdf %

Located in Folder default

10thGr_SS_WH_DA1_1415_APpdf

aty [ | Addto Cart |

Located in Folder default

11thGr_SS DA1 1415 AP di lysis.pdf

= aty | | Addto Cart |

Located in Folder default



All About Ordering

Our website is very user friendly and
made to make your ordering experience [ oo s S

= ltem 1 W ReplaceFile | | Continue Shopping
a-S e aS aS OS S I e We O e r I I l al l i RECOMETERCHER Y Unit Price 50.01
" ‘5 1Page .
cuN 8.50x11.00 Inches Quantity [1
YOURE 4N
u
TRACHER Click the image ta review the procf.

= L] L =
fl I l I S I I I I l O tI O n S a e rS a n d ‘ l | Sto I I I Select your print options, then click Preview to review this item prior to ordering.
b} b} Your Selected Print Options Print B/W, 1-Sided, 8.5 x 11 White 20 Ib, Scale Down Only

i Preview / Change Options

= = = =
options as well. The following slides will | =
u I have viewed the proof and preview (when available) and approve the document for printing.

Enter special instructions for this item.

give you an in-depth view of what you

Note: Only dates when the print center is open may be selected.

I would like my order shipped by: Tuesday, June 06, 2017

= =
Lauren Tarbet " Select a Shipping Method
- n;ngWINIS'TRRTIVE PISD DELIVERY ¥ | This will be delivered with campus mail

E:Tti;i States Delivery Estimate

Wednesday, June 07, 2017

Ordered ltems Quantity
1 ESOME TE, .pdf

Enter shipping instructions for this recipient

Billing Information

Lauren Tarbet Vi Order Estimate $0.01
ADMINISTRATIVE Click the price fo view the cost defails
500 I
Texas Select Billing Codes for Payment
United States District Account Code  No Valid Account Codes 0 %

If the account code is not found in the dropdown box
above, please

nter it below:

District Account Code 0 %
Example: 199.11.6399.00.000.7.99.100

OUT of District Cash/Check A 0 %
Specify Cash or Check and taxabie or non-taxabis

Total Split Percentage 0%



All About Ordering

You can change the order name to something representative of the job by clicking on the pencil

J1/Cart
Select print options =~ o -~rinient and billing information. Click Place Order to submit your order CartID 302249

Order nz 1e Awesome Teacher Flyer * Order Estimate $0.01

Item 1 i | ReplaceFile  Continue Shopping |

AWESOME TEACHER. pdf Ve Unit Price $0.01
1 Page

8.50x11.00 Inches Quantity |1

Click the image to review the proof.
Select your print options, then click Preview to review this item prior to ordering.

Your Selected Print Options Print B/W, 1-Sided, 8.5 x 11 White 20 Ib, Scale Down Only

a Preview / Change Options

Please approve this document for printing:

1 have viewed the proof and preview (when available) and approve the document for printing.

Enter special instructions for this item.

Shipping Information
| would like my order shipped by: Thursday, June 08, 2017 Note: Only dates when the print center is open may be selected.

Lauren Tarbet /" Select a Shipping Method
ADMINISTRATIVE | PISD DELIVERY r | This will be delivered with campus mail.
200 -
Texas

United States Delivery Estimate

Friday, June 09, 2017

Ordered Items Quantity
1 AWESOME TEACHER.pdf 1

Enter shipping instructions for this recipient

Billing Information

Lauren Tarbet Order Estimate $0.01
ADMINISTRATIVE Click the price to view the cost details

siy Select Billing Codes for Payment

Tevas




All About Ordering

The default for all copies is black and white print on white paper, printed front and back
(when multiple pages are present).

These settings can be changed by 2 Cart

Select print options, quantity per recipient and billing information. Click Place Order to submit your order CartiD 302249

Selecting Preview / Change Options ——— r———

Item 1 Wi | ReplaceFile | Continue Shopping |

AWESOME TEACHER.pdf 7 Unit Price $0.01
1 Page )
8.50x11.00 Inches Quantity 1

Click the image to review the proof.
Select your print options, then click Preview to review this item prior to ordering

- Print B/W, 1-Sided, 8.5 x 11 White 20 Ib, Scale Down Only

{7 § Preview / Change Options

Please approve wis aocument for printing:

1 have viewed the proof and preview (when avai t for printing.

i i f is i

Shipping Information
1 would like my order shipped by: Thursday, June 08, 2017 Note: Only dates when the print center is open may be selected.

Lauren Tarbet " Select a Shipping Method
ADMINISTRATIVE PISD DELIVERY v This will be delivered with campus ma
900
Texas

Dridieg Statee Delivery Estimate

Friday, June 09, 2017

Ordered Items Quantity
1 AWESOME TEACHER pdf 1

Billing Information

Lauren Tarbet ”: Order Estimate $0.01
ADMINISTRATIVE Click the price to view the cost detaiis

900 Select Billing Codes for Payment

Tavas




All About Ordering

For quick changes use the 1- Click Print Options (most common print solutions)

/ Print Options - AWESOME TEACHER.pdf Print Options Summa Unit Price $0.01 Quantity 1 Help

IR DL

i) Click to select from a list of

B/W 1-sided (ex. Answer Docs.)

1-Click Print Options a
o s h B/W 1-sided Hole Punched
|
[ Output - B/W 2-sided Hole Punched
B/W =
Paper = 1 sided eolor

8.5 x 11 White 20 b

Scaling
| scale Down Only

KEEP

Covers

o CALM

Folding/Punch

o YOU’RE AN

Additional options are available by right-

clicking on pages in the Preview, Scroll
View, and Grid View
Click here for more help

RN

Done With Print Options



All About Ordering

For customized print solutions click on additional options under Refine Your Print Options

KEEP
CALM
YOU’RE AN
AWESOME
TEACHER

B | iy

SN

'y
A
v
Y




All About Ordering

To switch from the default B/W setting click on Output and then select Color

=y Click
‘9 1oclick p
~F. -
‘ Output
B/W

PPPPP
Scaling
| Scale Down Only

B o KEEP

CCCCCC

- .
Binding '
L &
Folding/Punch '
L @
otl t shown) ' ,
- .
Additional o availa righ
clicking on Previ croll
d Grid

ons

ickil pages in the iew,
View, and Grid View.
Click here for more help




All About Ordering

Individual pages can be changed to color or b/w by opening the Grid View at the bottom right
corner. Right click on each page to select color option

oooooooo

.5 x 11 White 20
[7] Scali '
(1] scale Down Only
ex *
2-Sided / Long Edge Flip
CCCCCC i

Binding

=, Folding/Punch ' ,
= YOU’RE AN
ooooooooooooooo '

Additional options are available by right- AW E S 0 M E
clicking on pages in the Preview, Scroll

View, and Grid View.

Click here for more help T E ! C H E R




All About Ordering

To change paper color, stock, or size, click on Paper

/ Print Options - AWESOME TEACHER.pdf Print Options Summary Unit Price $0.23 Quantity 1 Help

Quick Sets
:= Click to select from a list of
ti 1-Click Print Options

v

Booklets

L © T

Refine Your Print Options
Output

Color

Select Paper

Current Paper: 8.5 x 11 White 20 Ib
Paper

8.5 x 11 White 20 Ib Use the filter options below to view the available paper choices.

Size |USLETTER |
The paper size has been preselected for you.

Scaling ' Color [any ] Resetiners.

Scale Down Only

v These papers match your color, size and filter options. Click on the paper name to select it. To make no changes and keep the Current

s Paper selection shown above, click Cancel.

2-Sided / Long Edge Flip

Name Color Size

Covers [1]8.5x 11 White 20 Ib white USLETTER

T | 8.5% 11 Blue 20 Ib blue USLETTER

Binding [ 8.5x 11 Light Green 20 Ib green USLETTER

T [J|8.5x 11 Pink 20 Ib pink USLETTER

i 4 [ 8.5x% 11 Yellow 20 Ib Canal USLETTER
Folding/Punch ry

.- W 85x11 Lilac 20 b Lilac USLETTER

Other (not shown) " [ 8.5x 11 Goldenrod 20 Ib USLETTER

O e W |8.5x11 Cherry 20 Ib Chemn USLETTER
Yy ¥

[J/8.5x11 Ivory 20 Ib Ivory USLETTER

goldenrod

Additional options are available by right-

clicking on pages in the Preview, Scroll
View, and Grid View.

Click here for more help

B 8.5x 11 Salmen 20 Ib

[ 8.5 x 11 White Coverstock 90 |b
[J{ 8.5 x 11 Canary Coverstock 90 Ib
[ 8.5 x 11 Blue Coverstock 67 Ib

Salmon
white

yellow

blue

USLETTER
USLETTER
USLETTER
USLETTER

Page 1




All About Ordering

Standard size documents can be printed larger by selecting Size. Please note that to make the
Image fit the page, you must then click on Scaling and select Scale to Fit. Default is set to scale
down

Unit Price $0.23 Quantity 1 Help

ets ' 3
e .
., r] .
Refine Your Print Options
& Output J
o e
x 11 White 20
L:\ Scaling s
| Scale Down Only

Plex ’
: 2-Sided / Long Edge Flip

o> CALM

Binding

o YOU'RE AN

ttttttttttttttt

| @ S

e AWESOME
clicking on pages in the Preview;, Scroll

View, and Grid View.

Click here for more help

\7@} 4 < Page 1 > >l B | g

Done With Print Options |




All About Ordering

Click on Plex to switch between single-sided and double-sided printing. (Please note, if you have a one
page document, and want the image on both sides, selecting 2-sided will not put the image on both sides)

Print Options Summa Unit Price $0.63 Quantity 1 Help

 Print Options - AWESOME TEACHER. pdf

Quick Sets

i= Click to select from a list of
: 1-Click Print Options

Booklets

Refine Your Print Options 5 V.“\%%
&) Ovtput

Color

o —

13 x 19 Coverstock

Scaling '

Plex | ded
L2l 2-Sided / Long Edge Flip ) 1-side

£
Covers . -Sii i
Q" 2-Sided / Long Edge Flip CAI M
v

rn

fr—

—— YOU’RE AN
AWESOME
TEACHER

Additional options are available by right-
clicking on pages in the Preview, Scroll
View, and Grid View.

Click here for more hell

Page 1 > pl (§55] L]Q[J
Done With Print Options

[0

ry
A




All About Ordering

Click on Covers to view cover options. This allows you to have a different paper type on the front,

back or both of your packet. If you want different papers on front and back, click to configure them
separately.,.... ...

=% Quick Sets

BgW 0 AlsF4

D Paper
8.5 x 11 White 20 Ib
Scaling
i | Scale Down Only
I% Plex
1-Sided
Covers

.

Additional options are available by right-
clicking on pages in the Preview, Scroll
View, and Grid View.

Click here for more he

AWESOME
TEACHER




All About Ordering

Click on Binding to choose from a range of available options. There are several stapling options, as
well as coiling (must have at least 20 pages if printing single-sided or 39 pages if printing double-sided).

H AWESOME TEACHERcolormulti pdf has been added to your order.

g Clickto select from a list of
: 1-Click Print Options

Booklets

Refine Your Print Options
& output
B/W

Paper
8.5x 11 White 20 Ib

Scaling
il Scale Down Only

g@ Plex
4. 2-Sided / Long Edge Flip

Covers
...

Binding
. g i

’ 1 .
Folding/Punch @
I \ " -

v

Other (not shown) Single Portrait  Single Landscape  Dual Porirait: Left Dual Landscape: Left Dual Landscape: Top

Additional options are available by right-

clicking on pages in the Preview, Scroll @j

View, and Grid View.

Click here for more heij

Dual Portrait: Top

Plastic Coil (Ne setup Fee for Clear)
PLEASE NOTE:Coiling requires a minimum of 2 weeks lead time

&z
Clear (8Bmm)

Collation

Uncollated

KEEP
CALM
YOU’RE AN
AWESOME
TEACHER

4 « Page 1 > pl




All About Ordering

Click on Folding/Punch to show you paper folding options as well as 2 and 3 hole punching.
Please ensure that page is set up correctly so that image overlap does not occur when folded.

Hep (2

 Print Optior WESOME Unit Price $0.10 Quantity 1
Quick Sets
iz Click to select from a li
iq 1-Click Print Options
U BBBBBBB
" D 000 et
Refine on
§ Outout
B/W
D PPPPP
8.5x 11 White 20 Ib
Scaling
I| scale Down Only
Plex '
7 2-Sided/ Long Edge Flip
CCCCCC
Binding
.

YOU’RE AN
AWESOME
TEACHER

3]
4 < Page 1 > b ERrED




All About Ordering

Other section allows for additional customization of print orders which includes:

> Business Cards

> Notepads

= Custom cutting orders ( please note we can only do straight cuts. If images are too close together some image clipping may occur)
@

Unit Price $0.10 Quantity 1 Help

Print Options Summary

« Print Options - AWESOME TEACHERcolormulti.pdf

Quick Sets
s= Clickto select from a list of
Ti 1-Click Print Options

»

o Booklets
Refine Your Print Options
& output '
B/W
Paper v e
8.5 x 11 White 20 Ib Other Finishing Options - AWESOME TEACHERcolormulti.pdf
i Scaling D Cut into Business Cards
Scale Down Only Cut in Half (Units of 500 sheets- 30 sheet minimum)
;I.:ded/ Long Edge i ' Cut in Thirds (Units of 500 sheets- 30 sheet minimum)
Cut in Fourths (Units of 500 sheets- 30 sheet minimum)
o f:fte'rs ' Cut in Fifths (Units of 500 sheet- 30 sheet minimum)
Cut in Sixths (Units of 500 sheets- 30 sheet minimum)
Binding '
o . Cut into more than six sections, please specify in instructions (Units of 500 sheets- 30 sheet minimum)

Folding/Punch Padded: 1 Full Pad (S0 sheets)
O Sooo Padded: 2 Half Pads (50 sheets)

o Other (not shown) Padded: 3 Third Pads (50 sheets)
T Padded: 4 Quarter Pads (50 sheets)

Padded: 1 Full Pad (100 sheets)

Additienal options are available by right-

clicking en pages in the Preview, Scroll -

View, and Grid View. Padded: 2 Half Pads (100 sheets)
. Padded: 3 Third Pads (100 sheets)

Click here for more hel

Padded: 4 Quarter Pads (100 sheets)

[Gose |

I =MWl




All About Ordering

After you are done selecting your finishing options, simply click the X at the top right, or Done With
Print Options at the bottom middle.

BBBBBBB

ot
o H

% 11 White
Scaling
I| scale Down Only
Plex '
7 2-Sided/ Long Edge Flip

CCCCCC

CALM
YOU’RE AN
AWESOME
TEACHER

Binding




All About Ordering

To prevent issues we have added the Proof Approval Checkbox. You must check this for the order to go through. By checking the box
you are stating that everything is exactly as you want it. If you have additional requests that were not provided in the finishing section,
please put a comment in the Special Instructions area.

Home | My Account | Help | Logout

1/ Cart
Select print options, quantity per recipient and billing infermation. Click Place Order to submit your order. CartlD 302488

Order name Order 302488 (SurePDF) Order Estimate $0.10

Item 1 i  ReplaceFile | Continue Shopping

AWESOME TEACHERcolormulti.pdf rd Unit Price $0.10
39 Pages }
8.50x11.00 Inches Quantity |1

Click the image to review the proof.
Select your print options, then click Preview to review this item prior to ordering.

Your Selected Print Options Print B/W, 2-Sided, 8.5 x 11 White 20 b, Scale Down Only

i Preview / Change Options

Please approve this document for printing:
+f 1have viewed the proof and preview (when available) and approve the document for printing.

Enter special instructions for this item.

Shipping Information
| would like my order shipped by: Friday, June 16, 2017 Note: Only dates when the print center is open may be selected.

Lauren Tarbet " Select a shipping Method
ADMIMISTRATIVE PISD DELIVERY v This will be delivered with campus mail.
200
Texas

United States Delivery Estimate

Monday, June 19, 2017

Ordered Items Quantity
1 AWESOME TEACHERcolormulti.pdf 1

Enter shipping instructions for this recipient

Billing Information
Lauren Tarbet 4 Order Estimate $0.10
ADMINISTRATIVE Click the price to view the cost details
00 Select Billing Codes for Payment
United States District Account Code No Valid Account Codes Q %
If the account code is not found in the dropdown box

above, please enter it below.




All About Ordering

Select your ship date by clicking on the calendar icon. The default date is 3 business days after submission. Please remember that you
will receive your materials with campus mail the day after it is shipped. If you do not need it for several days or weeks, please choose a
later date. You may also choose to Hold For Pickup directly below the calendar. If you choose this option, we are located at 2021 Crytal
Bend Drive, and are located in the portable at the back of the main building (pictured below)

Jd/Cart
Select print options, quantity per recipient and billing information. Click Place Order to submit your order CartlD 302488

Order name Order 302488 (SurePDF) - Order Estimate $0.10

Item 1 Tif ReplaceFile | Continue Shopping

AWESOME TEACHERcolormulti.pdf _~ Unit Price $0.10
39 Pages

8.50x11.00 Inches Quantity |1
YOURE AN
AWESOME
TEACHER Click the image to review the proof.

Select your print options, then click Preview to review this item prior to ordering.

Your Selected Print Options Print B/W, 2-Sided, 8.5 x 11 White 20 Ib, Scale Down Only
ﬁ Preview / Change Options

Please approve this document for printing:
+f 1have viewed the proof and preview (when available) and approve the document for printing.

Enter special instructions for this item.

Shipping Information
1 would like my order shipped by: Friday, June 16, 2087 il Note: Only dates when the print center is open may be selected.

Lauren Tarbet ~ Selectash hod
ADMINISTRATIVE PISD DELIVERY This will be delivered with campus mai
00

Texas

United States Delivery Estimate

Monday, June 19, 2017

Ordered Items Quantity
1 AWESOME TEACHERcolormulti.pdf 1

Enter shipping instructions for this recipient

Billing Information
Lauren Tarbet 4 Order Estimate $0.10
ADMINISTRATIVE Click the price to view the cost details
2 Select Billing Codes for Payment
United States District Account Code MNo Valid Account Codes Q %
If the account code is not found in the dropdown box

above, please enter it below.




All About Ordering

You must choose an account code before submitting your order.

o]

o

o

The account code(s) for your campus are listed in a dropdown menu. You must choose one of these codes before you can submit your order.
If you do not see the correct code, or you do not have a dropdown, you may enter it on the line below. You must use the format shown as an example.

Please only select Out of District Cash/Check if it is for personal use or for non curriculum items. Please also note that personal items must be
charged tax as well as a 20% upcharge fee.

You MUST add the percentage to the side of the account code or the order will not go through

Lauren Tarbet /" Select a Shipping Method
ADMINISTRATIVE PISD DELIVERY v [ This will be delivered with campus mail.
00
Texas

e Delivery Estimate

Monday, June 19, 2017

Ordered Items Quantity
1 AWESOME TEACHERcolormulti.pdf 1

Enter shipping instructions for this recipient

Billing Information

Lauren Tarbet * Order Estimate $0.10
ADMINISTRATIVE o S S
o Select Billing Codes for Payment
United States District Account Code No Valid Account Codes

If the account code is not found in the dropdown box
above, please enter it below.

District Account Code

Example: 199.11.6399.00.000.7.99.100

OUT of District Cash/Check v
Specify Cash or Check and taxable or non-taxable

101381 SpIN Fercentage uUws

Add Split | Click the 'Add Split’ button to add more Account Codes for split billing.

Enter billing instructions for this order

Start a New Cart Continue Shopping




All About Ordering

» When your order is complete click on the Place Order tab.

» You will be asked to confirm the price and the order will then proceed on to your bookkeeper or
the copy center depending on the amount of the order.

«/ 1have viewed the proof and preview (when available) and approve the document for printing.

Enter special instructions for this item.

Shipping Information
| would like my order shipped by: Friday, June 16, 2017 £ Note: Only dates when the print center is open may be selected.

Lauren Tarbet " Select a Shipping Method
ADMINISTRATIVE PISD DELIVERY ¥ | This will be delivered with campus mail.
900

Texas

United States . - - —

Your total is $0.10. Click Place Order to approve this price and place the order.

Place Order

Billing Information

Lauren Tarbet i Order Estimate $0.10
ADMINISTRATIVE Click the price to view the cost details
o Select Billing Codes for Payment
United States District Account Code No Valid Account Codes [4] %

If the account code is not found in the dropdown box

above, please enter it below.

District Account Code |
Example: 199.11.6399.00.000.7.99.100

OUT of District Cash/Check |Cash: Taxable v

Specify Cash or Check and taxable or non-taxable
Total Split Percentage 0%
Click the 'Add Split’ button to add more Account Codes for split billing.

Enter billing instructions for this order

Starta New Gt




Viewing an Order Status

» Click Orders to track the status of your order

» Use the view button to check the details of the order. Please note once the job has been submitted, you will no longer be able to
modify your order.

» Use the Reorder button to reorder a previously submitted job.

Home | My Account | Help | Logout

PRINTING MADE EASY

Ordering from Document Services has never been easier. Upload a File from your desktop,
search for personal items in My Files or search the Catalog.

New WebCRD Features!

Upload A File Search Catalog My Files Special Orders
Select a file from your desktop. Search catalog by description for items 10 Search your personal file cabinet for items Order custom prints from a hardcopy, CD-
order. 1o order. ROM, etc

=

| Choose Files | No file chosen | \

Advanced Search Advanced Search
Muitiple Files?




